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1. Overview:

LCDMaster is a low cost, yet very powerful Visuar&n Builder for color graphic displays. It alloyeu
to easily and cost effectively create high-end biegpfor embedded applications, without the need fo
expensive operating system and/or GUI library, oftw&are licensing or production fees and withowt th
processing power normally required for embedded §idtems.

LCDMaster is a true WYSIWYG visual GUI builder regng absolutely no coding for the GUI design.
This allows the marketing and sales personal tolirevdirectly in creating a unique look and feel thoeir
products, while the embedded engineers can focugriting and connecting the main application cduke t
created GUI.

The key for robust, user-friendly and elegant usterface is a prototype, test and repeat unisl iitght.
LCDMaster provides you with the tools to design aimdulate your screens with only few clicks and
without the need to have your hardware and code &vbe ready. This allows for rapid and effectiser
interface creation with minimum prototype cycle ¢éim

2. Features:

No license! No production fees!, No third partyréiby!, No RTOS!
Support all SEG-Cx panels

True WYS|WYG visual GUI tool

Simple drag-and-drop GUI tool

Powerful predefined set of objects

Real time user interface simulation

Real time object properties simulation

Bitmap editor/converter utility

Font converter utility

Full screen bitmap loader utility

One click compile and program

Generate project report

Copy and Paste tools

Zooming

Window's bitmap to binary converter utility

Export screen as a bitmap

Terminal commands utility

TouchScreen, Backlight, Keyboard, Digitall/O, PWRITC, Beep utilities

3. System requirements:

Intel Pentium 4, Intel Centrino or Intel Core Duw ¢compatible) processor
Windows XP

CD-ROM drive

512 MB RAM or higher

USB or RS232 Port

4. |Installation:

Insert the CD into your CD-ROM drive

Copy the folder “LCDMasterProVxxxx" and paste ityour hard drive C

From your hard drive C, open “LCDMasterProVxxxx'datiouble click on “Setup.exe”

Follow the instructions on screen to complete tistaillation

To run the software, click on “Start” and navigai¢'Haidar LCDMaster Pro” and then click on
“LCDMaster Pro Vxxxx”



5. Interface:

RS232 serial bus is used to communicate with thalsmntroller or the panel. You can use a USB to
serial converter if your PC have not a serial pddt all USB to serial converters in the marketapthave
the same performance, some of them may be nobtrifiar high speed interface. From our experience,
recommend to use Prolific USB to Serial converter.

6. Starting a new project:

We highly recommend keeping all project files whiobludes Window’s bitmap (.bmp), Binray bitmap

(.bin), Fonts (.bin), Project (.pjt) and Reporxkt).ion one location.

To start a new project (for example Demol), pldalew the steps:

1. From your hard drive C, create a new folder andenartDemol”

2. Open “Demol” and create the following new foldétsnts, ImageListO, ImageListl, ImageList2,
ImagelList3, ImageList4 and ImageList5.

3. From the main menu, select “New Project”, selectrytarget hardware and then click on “Apply”

4. From the main menu, select “Save As”, browse tdDEmol/”, enter the project name (e.g.
Demol.pjt) and then click on “Save”

From now, save all the project fonts and bitmaphéir corresponding sub folders, For example, sdive

fonts to “Fonts”, save all ImageListO bitmaps (.bam .bin) to “ImgeList0” folder and so on.

7. Product Select Utility:

The Product Select Utility provides fast and eaay to configure the software for specific product.

Product List: List Count | 2

T — .
SEG-COSF-LHT

Product Configuration:

Product SEG-CO57-LOT
LD T-55265GD057)-L'w-ABN

M ain Controller

FIC32

Graphic Controller

550149068

EEPROM

AT450BE42D

Touch Screen

TSC2200

Real Time Clock

None

Analog Input

4 Analog Inputs

PfM Dutput 4 Pt Outputs
Optical Encader Mone

Digital Input/Output 1E Digital 1/0
KeyPad 16 Keys

LCD Backlight LED

Calor Depth 1B

Color Format

LCD Resalution

LCD Resalution Y

LCD Size

Close |

Apply ‘

All supported products are listed on the “Produstitxt” text file, which is saved in the applicatipath.
The user must select the appropriate product bstaréng a new project. This will automatically
configure the software to the product specificisgt. To select a product:

Select the appropriate product form the produtt lis

Click on “Apply” to save and configure the software



8. Comm port, Baud Rate and Device ID Settings:

Communication

+ R5232
O USB

RS232

" Com Port 1
" Comn Port 2
" Com Poit 3
" Com Poit 4

" Dther 7
Device ID 15
BaudRale 1152 kb/ser +|

- Test
Cloze Cancel | Apply |

Communication OK | sLCD-COS7R Y1.00 030000

The Communication window is used to set the compatiin Com. port number, baud rate and device ID.
The selected baud rate and Device ID (communicatiliiress) must match the selected product baud rate
and device ID. Also, the selected com port mugteéx your PC and not be in use by another apjidina
The default values for the baud rate and devicéotall modules are:
Baud Rate = 115.2Kb/sec, Device ID = 0x10 = 16
If you use a USB to serial converter, the installech port can be from 1 to 255. In this case select
“Other” and enter the com port number. To testatiamunication between the software and the selected
product:
Make sure that the product under control is powerednd connected to your PC serial port using
Standard RS232 Cable
Click on “TEST”
If the test is successful, the TEST LED will tumd Green, the product number and firmware will be
displayed.
Note: USB communication is not supported by theentrversion.

9. LCD Controller Configuration Utility:

& Controller Settings
General T Comrmunication T
v Enable Touch Screen GF Outputs states
v Backlight iz ON at power up et GROO
" Load Screen at powerup | ™ Set GPO-1
Default BackColor . HO I~ SetGPO-2
System Colors RGE([565) I 5SetGPO-3
Light 57084 I SetGPO-4
Lightest E5535 — |
Datk 42233 LIGeLih o
Drarkest 33841 I SetGPO-B
Highlight 13045 i
[ SetGPO-7
TestHL B5535 2
Default . L
Cloze | | Cancel |




This utility is used to configure the target hardevar panel for particular display and set the
communication baud rate, device ID and, selecptwer up options.

See SEGE Software reference manual for more infi@mabout configuration bytes.

Note: Dip-Switch 3 must be ON “User Configuratidot the new configuration to take place.

Power Up Options:
- BackLight ON/OFF: This will configure the LCD contter to turn the LCD backlight ON or OFF at
power up or after a reset.
Load Screen: This will configure the LCD controlterload and show a screen#. The screen# must be
existed in the flash memory in order for this optto work.
Enable TouchScreen: This will configure the LCD trolter to enable or disable the touch screen
controller
Default Backcolor: This will set the default backar.
GP Output states: This will set or clear the cqroesling general purpose digital output
- System Colors: This will set the system colorseanbdefined in “Edit Display Window” utility.
Communication:
Device ID: This will set the communication addré3s
Baud Rate: This will set the communication baud rat

To program the configuration bytes, click on “Appind then click on “Send”. If the operation is
successful, you will receive an ACK and you neegddwer the target hardware OFF and then power it ON
for the new configuration to take place.

In case the baud rate and/or the device ID locatéoa corrupted or you are not able to communieéte
your target hardware. Set Dip-Switch 3 to “Defé&kgttings or OFF” and then sequence the power (power
off then on). This will set target hardware baue ta 115200 bit/sec and the device ID to 16.

From the communication utility, set the device D16 and select 115200 baud rate and then click on
“TEST”. If the test was successful then, from th€D Controller”, set the device ID and the bauck rtat
your desired settings and then click on “Apply” @hdn “Send”. Power the target hardware OFF and set
Dip-Switch 3 to ON again. Power the target hardwakéand the new configuration should be in place.

10.Touch Screen Utility:

This utility is used to test and calibrate the toscreen.

Touch

coordinat X [ 198 Virtual
Y [183 <« Touch
Touch ——W P [ Screen
Pressur Touch Staus
-t Scan Touch
s/ L screen
Touch Statu

Callbration Sean Msnlav

= o= @ Line

[ | ~oa Calibrate

Touch 4 = _
calibration — = Lee] ] Touch

b= 4/ S
ici creen
coefficients et | s |

ALK

[By= Stop




11.Terminal Utility:

This utility is used to test the Terminal commarfise “SEGE Software Reference Manual” for more

information about the terminal commands.

12.Bitmap Editor:

This utility is used to edit bitmaps or convernhéps to binary format.

Check Flash. How ma
Ids still available for the
selected imagelist

Select ImageList. Bitm £y
will be saved/displayed = | -

toffrom this ImageList ™1 inaselt

lirnag T\ 95 3K

ImagelList Max No.of
bitmaps and Max bitmap
size

Set Bitmap Size
e =
widh [
Height l_

: ) -
Set Bitmap size—— |

Back Shyle

0-Opage |

Apply |

Select Bitmap Back style/"

v =
e
Pick Transparent colo/
e
Rotate/ 1
-

O
|
Invert =
Convert to B&W p 4

Move ———— |

Save Mode Bitmap I

|Get Free D

i3] ;|| 0

Cleartarge ~ Displa Save the displayr ~ DisPlay ¢
display Bitmap on bitmap to Flash bitmap
scree| target display / from flas

Free  Used

| I |

Change |

Biep Szl
128X128
Pisel (Y]

Back Colar

Current Color [l

More Colors
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Select Color— w |

Delete
bitmap

Delete al
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To save a window's bitmap (.bmp) to the target e flash memory:

1. Select ImageList. The bitmap will be saved in thiage list.

2. Click on “Open” and select the bitmap (.bmp) filen error message will be displayed if the bitmap
width or height is higher than 255 or if the bitmgpe is larger than the ImageList Max. bitmap size

3. Set the bitmap back style. If you select “Transp#elick on “Pick Transparent color”, move the

mouse cursor to the bitmap transparent color agul lft click. The value of the selected transparen

color will be displayed on the text box. Make stirat, the transparent color is only existed inaresa
that you like to be transparent (not drawn).

4. Click on “Send To LCD” icon. The bitmap will be giayed on the upper left corner of the target
display.

5. Select “Save Mode”. “Get Free ID” mode will autoiatly find a free ID location for the selected
image list. “OverWrite” mode will over write thetbiap ID entered in “Bitmap ID” box. If you select
“OverWrite” then, set the bitmap ID before savifig. check how many IDs are still available for the
selected imagelsit, click on “Check Flash” icore free and used bitmaps will be displayed.

6. Click on “Save to Flash” icon.

7. To display the bitmap, click on “Show From Flash”.

8. To save the bitmap in binary format to your PGslcthn “Save”, the name of the bitmap will be
automatically generated as “IDx-ILx-bitmap name&niclick on “save”. In binary format, the bitmap
ID and ImageList code will be saved in the bitmaadter.

13. Font Editor

This utility is used to convert a system font todyly format and to save it to the target hardwkashf
memory.

Save the converted Show the selected characte€heck how many Delete Delete all
font to flash memory  (in red) on the target displayonts are still available _ font fonts

T

Import syster
font including
true type fonts

Set font ID

-

\ Select Sav

Mode

Convert font to
binary format




Eight fonts are provided for proportional writing.proportional writing, the characters are written
according to their width with one blank pixel beemethem. All characters are written with proporéibn
spacing. The character width and height are auioailyt calculated for the selected character.

The imported font size should not exceed the mawiroharacter cell size, which is 24X40.

TTF Import: A Windows TTF font is vector based, and will bewn using the full color depth of the
Windows system. This results in many shades of gedyg used to represent the individual charaéter.
fonts in LCDMaster are purely monochromatic (omiptcolors, or pixel states, on and off) there niest
made some sort of conversion, reducing the grale&¥indows characters to black-and-white LCDMaster
font characters. The black/white ratio slider deiees how dark a pixel must be, in order for LCDkas

to perceive it as black, and not white. Some fantésbest imported with the slider near the middisiton,
while others will be better represented if theelits pushed more toward the right. It is easyxfzeement,
because the import can be repeated again and agaig, slightly different slider settings. If thaport
covers a very large range of characters a smalterange can be used when adjusting the sliderder

to speed up the response.

To convert a system font to binary format and sateethe target hardware flash memory:

1. Click on “Import System Font” button, select forme, size and style then, click on “OK”.

2. Adjust the TTF slider if it is necessary.

3. Click on “Convert” button to convert the font tanbrry format.

4. Select “Save Mode”. If you select “OverWrite”, thenter Font ID number. If you select “Get Free
ID”, then the font ID number will be automaticatigtermined by the target hardware firmware. In
case you have selected “Get Free ID” and all abkiléont IDs are already used, then you need to
select “OverWrite” mode and to enter an ID number.

Click on “Save To Flash” to save the font to theyéd hardware flash memory.

To display a character on the target hardware ayslick on a character (will turn into red) amem
click on “Show Font” icon.

7. To save the converted font to your PC, click onv&8g enter font name and click on “Save”

8. To open a binary font file (.bin), click on “Operiighlight the font and then click on “Open”

5.
6.

14.Ilmage Loader:

This utility is used to save a full screen bitmapgge) to the target hardware flash memory

Load Image

The image W&H must
< be the as the target

display X&Y resolution

For example:320X240

1\ Convert image

RGB565 format

To save an image to the display flash memory:
1. Click on “Load Image” to load an image (Full scrdgtmap)
2. Click on “Convert”



3. Click on “Send To LCD” button to send the imagehe display

4. Atfter the whole image is already shown on the tadggplay, select “Save Mode” and ID and then
click on “Save to Flash” button.

5. Todisplay an image from flash, select image id berrand then click on “Show From Flash” button.

15.Bitmap to binary converter:

This utility is used to convert a list of windowb&maps (.bmp) to binary (.bin) with a single clickach
bitmap in the list will be converted to binary asalved at the same location as the window’s bitmBips.
Bitmap ImageList, Backstyle and Transparent colifirbve set for all bitmaps according to your segsn
Bitmap ID will be automatically set for each bitmstarting form “ID Start”. All converted bitmap wihe
saved with the following nhame format:

IDn_ILm_BitmapName

Where:

N is the bitmap ID

M is the bitmap ImageList

BitmapName: is the name of the window’s bitmap

Always check the “ID Start” before converting sauy@o not over write already converted or saved
bitmaps. Also, be sure that all bitmaps in theHes a size equal or less than the maximum siziador
selected ImageList and the number of bitmaps idishés equal or less than ID End — ID Start.

If you are going to convert a list of bitmaps theg a part of Animation or Image Sequence therube s
that they are loaded in the proper sequence.

Bitmap width, height and size.
They will be shown in red if any of them is higher
than the maximum for the selected ImageList
< and select

multiple bitmaps

Bitmap prewew4> at the same time

Hold “Ctrl” down

List of window's >

bitmaps

To convert a list of window's bitmaps (.bmp) to &ip:

1. Be sure that the list is empty. If it is not, click “Remove All”

2. Click on “Add Bitmaps” button, the Open dialog wilé displayed. Browse to the location of the
bitmaps and then hold “Ctrl” down and select mudtipitmaps at the same time. If you are going to
convert an array of bitmaps, then start from thiédoo of the array list. For example, if you arergpi
to convert Batteryl.bmp to Battery8.bmp, then selattery8.bmp first, then Battery7.bmp and so on.



3. Select the ImageList
4. Select the BackStyle. If the backstyle is “Trangpdl; then click on the color picker button andnfro

the bitmap preview window, move the mouse cursdhécbitmap transparent area and then right click

to capture the Transparent color. The backstyleteam$parent color will be set for all bitmapslie t
list.

5. Enter the “ID Start”. Be sure this ID is availalite the selected image list. For example, if yoeadly
convert 10 bitmaps starting for ID Start = 0 andestnem in ImageListO and you want to convert
another 15 bitmaps, then you need to set ID SiekOt

6. Click on “Convert”. Each bitmap in the list will lmnverted to binary and saved to the same location

as the window’s bitmaps starting form the first am¢he list. The ID of each bitmap will be
automatically set as an increment of the previmesand starting from “ID Start”.

16. Main Window:

The main window has four panels:

16.1.Virtual Display:

The Virtual Display is basically a picture box wlemou will be able to graphically layout your apglion
screens. It has the same resolution as the taispay with zoom in and zoom out capability.

16.2. Project Manger:

The Project Manger displays a hierarchical listhef project screens and all the objects contaiyeshbh
one. Clicking on a screen node in the list will@unatically show the screen on the virtual displagt,af
“Show the screen on the target display” is chedked, the screen will also be shown on the tarppial.

10



Clicking on an object in the selected screen lifithighlight the object (the color of the objecirhs into
Yellow) which will allow you to use the layout taoto edit, move or delete the highlighted object.
16.3. Object Menu:
The Object Menu shows all LCDMaster predefined otsjeClicking on any of the object buttons will ape
the “Object Property” window. Edit the object projes and then click on “Add” to place the objenttbe
virtual display.
16.4.Main menu:
The Main Menu all the software current functions.
File Functions:
New Project: Starts a new project.
Open Project: Opens a project.
Save Project: Saves a project under the currenenam
Save Project As: Saves the project under anotheena
Export Screen As Bitmap: Exports the current sceeewindow’s bitmap (.bmp). This allows you to
open the exported screen using any Graphics desityware and uses its tools to print or edit the
screen picture.
Exit: Exits the software.
Edit Functions:
Display: Edits the virtual display colorsdamther settings
Palette: Edits the palette colors for 8slyigtems.
Highlight All: Highlight all objects.
Unhighlight All: Unhighlight all objects.
Delete: deletes all highlighted objects.
Project Functions:
Select Product: Selects a product form tloelyct list.
Load Font: Loads a new font (.bin) to th&ware font list. This will not affect the targeatdware
fonts. For example, use the font editorreate a new font, save it to your PC and thenhise t
Utility to save it to the application foniemmory.
Compile And Program Screen: Compile and wgthe current screen only.
Compile And Program All: Compile and progralhthe project screen.
Generate Header File: Generates a C compatibject header file (.txt). This file contairls a
commands, codes, object property codes ltlibgoroject screens and objects names and IDs.

SetUp Functions:

Communications: Edits the communicationisgst

LCD Controller: Edits and program the targatdware configurations.
Options: Edits the software starting up st

Utilities Functions:

Font Editor: Displays the font editor ulit

Bitmap Editor: Displays the bitmap editoitityt

Image Loader: Displays the image loadeityatil

Bitmap To Binary Converter: Displays thenfdip to binary converter utility.
Terminal: Displays the Terminal utility.

Touch Screen: Displays the touch screertyutil

Keypad: Displays the keypad utility.

Digital 1/0: Displays the Digital Input/Ouip utility.
Analog In: Displays the Analog input utility

PWM: Displays the PWM (Pulse Width Modulajautility.
Backlight: Displays the back light utility.

Beep: Displays the beep (buzzer) utility.

Help Functions:
About: Displays the About screen.

11



16.5. Layout and Programming tools:

Selected Screen Number of use

- Draw Mode
screens for the - Number of pixel | _ Objects or Touch Zones
current project to move
Highlighted Object
Highlighted Object Le
Number of use Move Up, Down and Top
objects for the Left and Right
Highlighted Object selected scres 9
ID and Code ]
Mouse cursor X andY
v v i
v
v
v v

Interface List of Fonts Grid

Simulation -
Copy Objec

Program

? A A ? A T A A A
User Program a Paste Obje: Show/Hide

Objec List of .
Commands Bitmaps Delete Object
Simulation

Program a UnHighlight

Compile List of all object:
And Images (full ||
Program screen
All Screen bitmap) Edit Objec

Properties
Compile
And
Program
Current
Screen
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16.5.1. User interface Simulation:

This utility allows you to test and manually simtglahe objects touch zones. The object command
“Screen_GetUiMsg” is sent periodically every ~25@mghe received user interface message is decoded
and displayed. The host controller will use the s@mammand to capture the user interface message.
Please, check SEGE Software Reference manual fiog immrmation.

The scree

objects touch
User Interface zones will be
Message > drawn in red.
(UiMsg) < When an object

is touched, the

corresponding
Scan/Sto

touch zone will
Buttons \ turn into green

Rx/Tx LED 2

Data ser
(Screen_GetUiMsg
command) and data<:
received (ui_Msg) in
Hexdecimal

To start the user interface simulation:

1. Select the screen that you want to perform thisikitiron on and be sure that is already displayed on
the target hardware display too.

2. Click on “User Interface Simulation” button

3. The user interface simulation window will be digmd. The touch zones for the screen objects will be
drawn in red.

4. Click on “Scan”

5. From the target hardware display, touch an objedta same time observe the response on your PC
monitor.

16.5.2. Object Commands Simulation:

Screen objects list——p> 4—— Object Properties

Screen commands_>

Object commands———p»

Enter object value as

4——— String, Byte, Word
or DWord

Data sent and received—73p»
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This utility allows you to test the object commarasl manually simulate your GUI even before your
hardware and code to be ready. Also, it is a goedtto debug your code during the design procis.
object commands, object properties and methodsugmgorted.

For example, you can play an animation, write & texextbox or button label, move a radial gaugedie,
fill a chart with array of numbers and so on. Tlhdadsent and received are also displayed for debggg
and testing purposes.

Please, check SEGE Software Reference manual for imimrmation about the object commands,
properties and methods.

To test an object command or method:

1. Select the screen that contains the target objgtba sure that is already displayed on the target
hardware display.

Click on “Object Simulation” button.

The “Object Simulation” window will appear.

From the “Screen Object List”, select the object.

From the “Object Properties List”, select the pmtyp¢hat you need to set or to get

From the “Object Command List”, select the objemhenand or method and enter the command data
(string, byte, word or dword) if Object_SetPropdstgelected.

7. Click on “Send” and observe the change on the tatigplay.

oukwhN

16.5.3. Compile And Program:

This utility is used to compile a single screerdstd screen) or all the project screens intaarifile
(Hex file) and send it to the target hardware te#eed in the flash memory. Every time you create a
screen or edit an object, then you need to conapiteprogram. After you compile and program a sgreen
click on the screen in the project manger (make that “Show screen on target display” is checkedee
the new one or changes on the target hardware.

14



16.5.4. Program a List of Fonts:
This utility allows you to program a list of fontgth one click!

Font list —»

Add fonts to

/ the list

Program the

< list

To program a list of fonts:

1.

2.

3.

Click on “Add” and browse to the fonts location. IHECtrl” down and select one or more font file
(.bin). The number of fonts in the list should rateed the maximum allowable number of fonts
which is 8. The order of the fonts in the list & important as each font has its ID and ImageCixde
already saved in the file header.

Click on “Program”. Each font in the list will baxged (Over Write) into the target hardware flash
memory starting from the first one in the list.

Wait until all fonts are programmed and then click“Close”.

16.5.5. Program a List of Bitmaps:
This utility allows you to program a list of bitmsyp.bin) with one click!

To program a list of bitmaps in binary format:

1.

Click on “Add” and browse to the bitmaps locatiétold “Ctrl” down and select one or more bitmap
files (.bin). The order of the bitmaps in the Ishot important as each bitmap has its ID and khég
Code already saved in the file header.

Click on “Program”. Each bitmap in the list will saved (Over Write) into the target hardware flash
memory according to its ID and ImageList Code aadting from the first one in the list.

Wait until all bitmaps are programmed and thenkotio “Close”.

15



16.5.6. Program a List of Images (full screen bitmas):
This utility will program a list of images (.bmp)iti one click!

To program a list of bitmaps in binary format:

1. Click on “Add” and browse to the images (.bmp) lkima. Hold “Ctrl” down and select one or more
image files. The order of the images in the listasy important as the ID for each image in theWidl
be an auto increment (+1) of the previous ID stgrfrom the first one in the list (ID = 0).

2. Click on “Program”. Each image in the list will Baved (Over Write) into the target hardware flash
memory according to its ID and ImageList Code aadisg from the first one in the list.

3. Wait until all images are programmed and then dalink'Close”.

16.5.7. Copy/Paste Object:

To copy and past an object:

1. Highlight the object you need to copy.

2. Click on “Copy Object” button. The “Paste Obijectiliioe enabled.

3. Click on “Paste Object”. The object will be pastadhe upper left corner of the virtual displayeTh
software will generate a uniqgue name for the nejecitand add it to the project manger.

16.5.8. Delete an Object:

To delete an object:

1. Highlight the object you need to delete

2. Click on “Delete Object” button. A message box Wi displayed to confirm the action. Click on
“Yes” and the object will be deleted. This actisrundoable.

16.5.9. Edit Object Properties:

To edit an object properties:

1. Highlight the object you need to edit its propestie

2. Click on “Edit Object Properties” button. The oljgcoperties window will be displayed. Edit the
properties and then click on “Edit”. You must Cote@nd Program the screen to save the changes to
the target hardware flash memory.

16.5.10. Zoom In and Zoom Out

The zooming feature is only available if the tardjigplay resolution is QVGA (320X240) or less. For
higher resolution, only the actual size of the ¢éajsplay resolution will be displayed.

For QVGA resolution or less and if the screen betgle is background image, then you need to save th
background image with actual size (e.g. 320X24@)with double the size (e.g. 640X480). Only theuatt
image size will be saved into the target hardwkshfmemory, the second one is only for the softwar
zooming function. Both images must be saved aséimee path as the project.
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Actual size scree

background image.

Double the size of the <
background image. For example 320X240

For example 640X480

17. Starting Up Options:

At starting up, LCDMaster can be configured to Iéawks and object bitmaps and to set the
communication port number, baud rate and DeviceTtlimse configuration or options will be saved a$ te
file “Config.ini” to the application path “C:\Progm Files\LCDMaster VV1.00".

Initial Fonts Options

When the application starts, it will load
FontO to Font7 from
C:\LCDMasterProV1.00\Fonts

Initial Bitmaps Options

When the application starts, it will load the
NumberBox digit bitmaps (24) and put th
in ImageList2.

The Digit bitmaps are located at:
C:\LCDMasterProV1.00\NumberBoxDigits
ImgaelList2

17



Initial Communication Options

When the application starts, it will set:
Communication type = RS232

Com Port =7

Device ID = 16

Baud Rate = 115.2kb/sec

To configure the starting up options:

1.

2.
3.
4

6.
7.
8.

From the main menus, select “SetUp” and then sé@gtions”

The “Options” window will be displayed with the cant options.

Select “Communication” and enter your new settings.

Select “Bitmaps”, uncheck ImgeList2 to clear trst &nd then check it again. Click on “Browse” and
navigate to the new bitmaps location, select thadgs and then click on “Open”. The list will be
populated with new bitmaps files. Do the same foadeList3 and 4 if required.

Select “Fonts”, uncheck Font0 to Font7 to cleairthaths and then check FontO. Click on “Browse”
for Font0 and navigate to the new FontO locatiefect fontO file and then click on “Open”. Font0
path will be displayed. Do the same for Fontl to 7.

Click on “Apply” and then click on “Close’

Exit the application.

Start the application again for the new optiontate place.

18. Load Font:
This utility is used to load a font file (.bin) the application font memory. It is very useful ésttnew
fonts created by using the font editor.

19. Generate Header File:
This utility is used to generate a C compatibledegdile for the project. This text file contains a
commands, properties and object ID.
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20. Objects:

Please, see SEGE Software Reference manual for manéormation about each object properties.

20.1. Screen Object:

Screen Name \

Screen widgets or
Screen ID. The Screen IC <4— ; 9
; y/' objects count
automatically generated b

the application

Number of used at
Image (Full screen bitmap) ID still free screens
You must enter valid Image I_D/'
if you set the backstyle to
Image.
Actual Screen size
X2 image is double the size/v 4—— Dbackground Image

of the actual image. For For example: 320X240
example: 640X480

Only used for the zooming
feature.

To add a screen to an project:

1.
2.
3.
4

5.

From the object menu, click on the “Screen” button.

Screen object properties window will appear. Setstreen properties and then click on “Add”

The screen will be added to the project and tgtogect manger list.

To edit the screen properties, click on the screane in the project manger list, the screen will be
shown on the virtual display.

Click on “Edit” button and the screen object prajgesr window will appear. Edit the screen properties
and then click on “Edit”

Notel: Every project must have at least one sciren you start the application, Screen_0 will beéeal
automatically and can not be deleted.

Note2: If you set the backstyle to Image, then geed to load both images if the target displaylutiem

is 320X240 or less. You also need to enter the &iBythe image must be saved into the target harelw
flash memory at that ID). Both images must be winslbitmaps (.bmp) and must be saved at the same
path as the project.

20.2. BarGraph Object:

Bargraph Name ————p

Bargraph colors. Only Bargraph value
if style is line > For simulation only

Bargraph Bitmaps.

Only if style is bitmapo,%
One bitmap for OFF

Cold segment.

One bitmap for ON1 or

Hotl segment.

One bitmap for ON2 or
Hot2 segment.

Bargraph bitmaps
preview
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To add a Bargraph to a screen:

From the object menu, click on the “Bargraph” batto

Bargraph object properties window will appear. thetBargraph properties and then click on “Add”
The Bragraph will be added to the project mangemdinder the selected screen node.

Move the mouse cursor to inside the virtual disglay left click to place the object.

To edit the Bargraph properties, click on the stne@me in the project manger list, the screentweill
shown on the virtual display and then click onltlaegraph name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondahe Bragraph object properties window will
appear. Edit the Bragraph properties and then dickEdit”. You can also move it by clicking on the
moving buttons.

arLONE

20.3. Button Object:

Label width, height,
of characters and # of

Font, Label Color and lines

Label. Only if style is
Bitmap&Label.

Button bitmaps
One for Not Pressed.

One for Pressed.
One for Disable
(optional)

Add any character from
32 to 255 to the button
label

Button bitmaps preview

"

Enable the button
Touch Zone >

/ If the button is touche
Touch Zone Offset < beep for 250msec

If the button is touche
enable NotifyHost pin.

If the button is touche
automatically toggle its
state.
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To add a Button to a screen:

arLONE

From the object menu, click on the “Button” button.

Button object properties window will appear. Set Button properties and then click on “Add”

The Button will be added to the project mangerdistler the selected screen node.

Move the mouse cursor to inside the virtual disglag left click to place the object.

To edit the Button properties, click on the scraame in the project manger list, the screen will be
shown on the virtual display and then click on Bugton name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondattie Button object properties window will appear.
Edit the Button properties and then click on “Editbu can also move it by clicking on the moving
buttons.

20.4. TextBox Object:

TextBox width and heigt
For Standard style, adjust
the width and height
according to the selected
font, text alignment and text
¢ width and height. Text will
be clipped if it is wider or
higher than the textbox.
For Static style, the textbox
width is the text width and

TextBox back color and its height is the text height.

fore color. Back color is

only valid for standard <‘.

style Text #of lines, #of

< characters, width and height

TextBox text. Multi line is

supported. Max 64 >

characters

To add a TextBox to a screen:

arONE

From the object menu, click on the “TextBox” button

TextBox object properties window will appear. Set TextBox properties and then click on “Add”
The TextBox will be added to the project mangdrdizder the selected screen node.

Move the mouse cursor to inside the virtual disglayg left click to place the object.

To edit the TextBox properties, click on the scraame in the project manger list, the screen weill b
shown on the virtual display and then click on TlextBox name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondaitie TextBox object properties window will
appear. Edit the TextBox properties and then aicKEdit”. You can also move it by clicking on the
moving buttons.
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20.5. NumberBox:

NumberBox simulate
value. You can test the
function of the
NumberBox by enterir
< different numbers and
see the effect on the

NumberBox Digit Bitmap: ) virtual display

The digit bitmaps (24
bitmaps) must be saved into
ImageList2, ImageList3
or/and ImagelList4. At starting
up, the application will load
them automatically from the
path you have entered on the
“Starting Up Options”
window.

Scroll up/down to see :
the 24 digit bitmaps

To add a NumberBox to a screen:

1.
2.

3.

From the object menu, click on the “NumberBox” butt

NumberBox object properties window will appear. ®et NumberBox properties and then click on
“Add”

The NumberBox will be added to the project manggninder the selected screen node.

Move the mouse cursor to inside the virtual disglag left click to place the object.

To edit the NumberBox properties, click on the saraame in the project manger list, the screen will
be shown on the virtual display and then click lve lumberBox name to highlight it (Yellow frame
will be drawn around the object). Click on “Editltbon and the NumberBox object properties window
will appear. Edit the NumberBox properties and tbck on “Edit”. You can also move it by clicking
on the moving buttons.

20.6. Slider Object:

Control bitmap Offsetx ar
Offsety relative to the body
bitmap. You adjust the offset
by editing the slider and
observe the effect on the

virtual display
SliderRange —_p . .
g Slider simulated value.
'\Adjust the slider value
Slider background ai » and observe the effeon
control bitmaps. the virtual display

<_S|ider bitmaps preview
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Enable the Slider Touch Beep when the slider is

Zone —> touched
Touch Zone Offset / Notify host when th
« slider is touched

Automatically move the
slider control or handle
when is touched and
dragged

To add a Slider to a screen:

From the object menu, click on the “Slider” button.

Slider object properties window will appear. Set 8lider properties and then click on “Add”
The Slider will be added to the project mangerdistier the selected screen node.

Move the mouse cursor to inside the virtual disglag left click to place the object.

To edit the Slider properties, click on tieeegn name in the project manger list, the scratev
shown on the virtual display and then click on 8tider name to highlight it (Yellow frame will bealvn
around the object). Click on “Edit” button and tBkder object properties window will appear. Edié t
Slider properties and then click on “Edit”. You calso move it by clicking on the moving buttons.

arONE

20.7. PictureBox Object:

PictureBox widthan ~———p
height. Enable free hand drawing.

<4—— PictureBox Touch Zone must be
enabled.

PictureBox background
bitmap. If the picture box
has no background bitmap
then it will be filled with

the back color. ) )
PictureBox background bitm

preview
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To add a PictureBox to a screen:

1.
2.

3.

From the object menu, click on the “PictureBox”tbut

PictureBox object properties window will appeart ®e PictureBox properties and then click on
“Add”

The PictureBox will be added to the project mariggmunder the selected screen node.

Move the mouse cursor to inside the virtual disglag left click to place the object.

To edit the PictureBox properties, click on theeger name in the project manger list, the scredn wil
be shown on the virtual display and then click loa PictureBox name to highlight it (Yellow frame
will be drawn around the object). Click on “Edititbon and the PictureBox object properties window
will appear. Edit the PictureBox properties anchthick on “Edit”. You can also move it by clicking
on the moving buttons.

20.8. Image Object:

ImageCount = Number
of bitmaps in the array.
Array Startindex = First
<+— bitmap ID in the array
Array Endindex = Last
bitmap ID in the array.

Load the Image object

bitmap array. For both styles

Animation or

ImageSequence, the bitmaps—pp

in the array must be saved

into the flash memory in

sequence. ImageCount

determines the number of

bitmaps in the array. First bitmap in array
All bitmaps must be saved to preview
the same ImagelList.

To add a Image to a screen:

arONE

From the object menu, click on the “Image” button.

Image object properties window will appear. Setlthage properties and then click on “Add”

The Image will be added to the project mangenister the selected screen node.

Move the mouse cursor to inside the virtual disglag left click to place the object.

To edit the Image properties, click on the scremmenin the project manger list, the screen will be
shown on the virtual display and then click onltimage name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondattie Image object properties window will appear.
Edit the Image properties and then click on “Editbu can also move it by clicking on the moving
buttons.
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20.9. Shape Object:

To add a Shape to a screen:

1.
2.
3.
4

5.

From the object menu, click on the “Shape” button.

Shape object properties window will appear. SetShape properties and then click on “Add”

The Shape name will be added to the project mdiggjemder the selected screen node.

Move the mouse cursor to inside the virtual disgag left click and hold the left button, move the
mouse to draw the shape then release the leftrbtdgtplace the shape.

To edit the Shape properties, click on the screenenin the project manger list, the screen will be
shown on the virtual display and then click on 8frape name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondaitie Shape object properties window will appear.
Edit the Shape properties and then click on “EdSu can also move it by clicking on the moving
buttons.

20.10. Chart Object:

Chart area width and height
will be calculated based on

Xmax, Ymax and Xspace. _—)

Width = Xmax * Xspace +4
Height = Ymax + 4

Chart Back Color B,

Series colors

—>
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To add a Chart to a screen:

arLONE

From the object menu, click on the “Chart” button.

Chart object properties window will appear. Set@art properties and then click on “Add”

The Chart will be added to the project mangerdigder the selected screen node.

Move the mouse cursor to inside the virtual disglayg left click to place the object.

To edit the Chart properties, click on the screemea in the project manger list, the screen will be
shown on the virtual display and then click on @ert name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondattie Chart object properties window will appear.
Edit the Chart properties and then click on “Edtau can also move it by clicking on the moving
buttons.

20.11. Needle Object:

Needle Range = from to 360

/ — (Amin + Amax )

Needle OffsetX ar

< OffsetY. Only if the style is
Analog Meter.

Needle background bitmé

Only if the style is _ >
AnalogMeter.

Needle preview. Move tl
value slider to move the
needle.

To add a Needle to a screen:

arLONE

From the object menu, click on the “Needle” button.

Needle object properties window will appear. Setiteedle properties and then click on “Add”

The Needle will be added to the project mangeuimster the selected screen node.

Move the mouse cursor to inside the virtual disglay left click to place the object.

To edit the Needle properties, click on the scre@me in the project manger list, the screen will be
shown on the virtual display and then click oneedle name to highlight it (Yellow frame will be
drawn around the object). Click on “Edit” buttondaiie Needle object properties window will appear.
Edit the Needle properties and then click on “Ed¥tdu can also move it by clicking on the moving
buttons.
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21. Getting Started with LCDMaster — “DemoCQ57_1"Project:
The installation CD includes a sample project “D€ub7_1". This project has 10 screens and eachrscree
focuses on single object with different styles &ypks. This project is also programmed into thgegr
hardware flash memory and ready to be used otteobdx.
To open DemoCQ57_1.pjt:
1. From the main menu, click on “Open” and windowsvising dialog will appear. In this dialog,
browse to “C:\LCDMasterProV1.00\Projects\Demolightight “DemoCQ57_1.pjt" and then click
open.
2. The project will appear on the project manager aoicten_Button will appear on the virtual display.

22. Manual Change History:

Date Revision Change

7/23/2010 REV 1.00 Initial Version of the LCDMaste
Reference manual

=
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Tutorials



Creating a New Project (Demo):

From you hard drive C, create a new folder and nariizemo”

Open “Demo” folder, create 7 folders and name thsrfollowing: Fonts, ImageListO, ImageListl,
ImagelList2, ImageList3, ImageList4 and ImageList5.

Start LCDMaster, select File > New Project anddefeur target hardware product (SEG-CQ57-LOT
or SEG-CQ57-LHT) and then click on “Apply”. The LQBsolution is QVGA (320X24).

Select SetUp > Communication, select a valid commpamber and click on “Apply”. Leave the baud
rate at 115.2kb/sec and Device ID at 16. Click dast” to check the commuincation between the PC
and the target hardware. Make sure that the tdigplay is already powered on and the connected to
the PC serial port through a standard RS232 cable.

Select File > Save As, standard window save dialitigappear, browse to “Demo” , name the project
“Demao.pjt” and then click on “Save”

Creating a New Font:

Select Utilities > Font Editor, click on “Import Stem Font” and windows standard “Font” dialog will
appear. Scroll down and Select “Arial”, set thetfstyle to “Regular” and size to “8” and then click
“OK”.

The font characters will be displayed on the famié. Click on a character (turn into red) to semi
the character matrix.

Click on “Convert” to convert the font into binafyrmat.

Select “OverWrite” for Save Mode and enter O far Font ID. The font will be saved as “Font0”.
Click on “Save To Flash” and wait until the foriefis completely sent and saved into the flash
memory.

To check if the font is converted and save coryectick on a character (e.g. “A”) and then click o
“Show Font”. Character “A” will appear at uppertlebrner of the target display. You can also use th
terminal utility to write lines of text on the tagdisplay and see how this font looks like on the
display.

If you are happy with font, click on “Save” and farge to “C:\Demo\Fonts”, name the font as
“Font0_Arial_8 R” and then click on “Save”.

To load this font to the LCDMaster font memoryes¢IProject > Load Font, click on “Browse” and
navigate to C:\Demo\Fonts\FontO_Arial_8 R and cbok‘Open”. Select “Font0” for the target font
and then click on “Load”.

To load this font at every time you start LCDMasg®lect SetUp > Options, click on Font tab, click
on Font0 Browse button and navigate to C:\Demo$i&ont0_Arial 8 R, click on “Open” and the
font path will appear on FontO path label. Click“@&pply” to the save the changes to “Config.ini”
file.

Demo Project first screen (Screen_Demo):

Copy “WindowForm.bmp” and “WindowFormX2.bmp” form

“C:\LCDMasterProV1.00\Projects\Demol\ImageList5tgmaste them into

“C:\Demo\Fonts\ImageList5”. We will use “WindowForomp” as a background image for

Screen_Demo.

From the project manger, click on “Screen_0" arghthlick on “Edit object Properties”. The “Screen
Object properties” will appear, name theesoras “Screen_Demo”, select “Image” for the bagles
and enter O for the image ID.

Click on “Load” for X1 Image and browse to “C:\DekRonts\ImageList5\WindowForm.bmp” and
then click on “Open”. Do the same for X2age and select “WindowFormX2.bmp”.

Click on “Edit". The new screen name “Screen_Deml' appear in the project manger list and the
screen back ground image will appear orvitteal display.

Now we need to save the background image to tisb fllemory at ID = 0. Click on “Program Image
List”, add “WindowForm.bmp” and then click 6Program”.

Now we need to save the screen to the flash merfitigk on “Compile And Program Current
Screen” and then click on “Start”.

Make sure that “Show Screen on the target displaghecked and then click on “Screen_Demo”. The

Screen should appear on the target display.
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10.

Add a Button to Screen_Demo:

Copy “StartGDown.bmp” and “StartGUp.bmp” from C:\D®asterProV1.00\Bitmaps and paste them
into “C:\Demo\lmageList0”. StartGUp.bmp is for thatton Not Pressed or Up state while
StartGDown.bmp is for the button Pressed or Dowtest

Now we need to convert the two bitmaps from windditap format (.bmp) to binary format (.bin).
Select Utilities > Bitmap To Binary Converter, &ion “Add Bitmaps”, browse to
C:\Demo\lmageList0 and select both bitmaps. SélawgeList0”, Opaque, and set the ID Start to O.
Click on “Convert”. The two bitmaps are convertedtnary and saved to ImageListO as
IDO_ILO_StartGUp.bin and ID1_ILO_StartGDown.bin.

Now we need to save the converted bitmaps to ##hfinemory. Click on “Program Bitmap List”, add
IDO_ILO_StartGUp.bin and ID1_ILO_StartGDown andrtdick on “Program”.

Now we need to add the button to Screen_DemO. Ener®bject Menu, click on “Button” , Button
Object Properties will appear. Name the buttonBagton_Start”, set the Style to “Bitmap” and se# th
type to “Momentary”. Select “Not Pressed” and clak “Load”, navigate to “IDO_ILO_StartGUp.bin"
and click on “Open”. Select “Pressed” and click‘bnad” again, navigate to
“ID1_ILO_StartGDown.bin” and click on “Open”. Clickn “Input/Events” tab, check “TouchScreen”
for the Input Type, and check also Beep, NotifyHasd Toggle.

Click on “Add” and then on “Close”.

Move the mouse cursor to inside the virtual disptayectangle with the button dimensions will appea
at the tip of the cursor. Click on “Left” to platiee button.

Now we need to save the changes to Screen_Denuk @li“Compile And Program Current Screen”
and then click on “Start”.

Click on “Screen_Demo” and the new screen shoufzapon the target display.

Touch the button using your finger or a stylus #relbutton should change its state from Not Pressed
to Pressed and beep for 250msec.
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11. You can also check the screen user interface wkatjUser Interface Simulation” utility.
12. Also, you can examine and test the screen runpimgerties and methods using the “Object Run
Time Simulation” utility.

Converting the button bitmaps to binary Button_Start Properties
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Add a bitmap style BarGraph to Screen_Demo:

Copy SegH_Off _8X24.bmp, SegH_On_8X24.bmp and SegiR @X24.bmp from
C:\LCDMasterProV1.00\Bitmaps and paste them ind@€@mo\imageList0. The first bitmaps is for
the cold or off segment, the second for the Hoghmnt and the third is for the Hot2 segment.

From “Bitmap To Binary Converter” utility, add theshree bitmaps, select ImageListO, set the back
style to Transparent, click on “Color Picker” buttand move the mouse cursor to the bitmap corner
(transparent color is white) and “Left” click. Thénite transparent color value will appear on the
transparent color label.

The Start ID should be “2” as we already use 1@ & for the button bitmaps.

Click on “Convert”. The bitmaps are converted todrsy and saved in ImgeListO as
ID2_ILO_SegH_OFF_8X24.bin, ID3_ILO_SegH_On_8X24.himd ID4_ILO_SegH_OnR_8X24.bin
with back style set to Transparent and the tramsparolor is white.

Click on “Program Bitmap List” and add the convdrteree bitmaps. Click on “Program” to save
them to the flash memory.

Click on “BarGraph” button. Name it as “BargraphtrBap”, set the style to “Bitmap”, set the type to
“Bar” and orientation to “Horizontal”. Select “Cdl@nd click on “Load”, navigate to
ID2_1L2_SegH_Off_8X24.bin and then click on “Opeo the same for “Hot1” and “Hot2".

Set SegmentCount and SegmentSpace to 8.

Click on “Add” and then on “Close”

Place the bargraph on the virtual display.

Click on “Compile And Program” to save the new opasito the flash memory.

0 Click on Screen_Demo and the new screen shouldaapethe target display.
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To change the bargraph value on the target display:

1. Click On “Object Command Simulation”, select BagnaBitmap, select “Value” property and then
select “Opject_SetProperty”.

2. Enter 0,3,1 and then click on “Send”. (0,3) isWard value of the bargraph (0x0003) and 1 is the
bargraph segment index. 0 > Off, 1 > Hot1, 2 > Hot2

3. On the target display, the first 3 segments wilhtinto “Hot1” bitmaps (Green).

4. Enter 0,3,2 and then click on “Send”, the firsegments will turn into “Hot2” bitmaps (Red).
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